
 Contents
Menu Commands

File Menu
Edit Menu
Options Menu
View Menu
Window Menu
Help Menu

FadeMax Windows

Using FadeMax

Keystroke Equivalents
Glossary of Terms
Error Messages
Miscellaneous Information

The information in this help file and the JukeMax program itself are Copyright © 1992 by 
Richard Johnson. All Rights Reserved. 
See the license agreement in the printed documentation for information on the limits of this 
license.



FadeMax Windows
The Mixer Window
The Event Editor
The Graphic Editor



Using FadeMax
Overview of FadeMax
How to Use FadeMax
The Transport Bar
Menu Commands



An Overview of FadeMax
FadeMax is 16 Channel Automated Mixer simulation. It will record and playback movements 
of its on-screen controls as well as record and play back control changes from external MIDI 
devices. Each FadeMax channel contains seven controls plus an led simulation. All channel 
controls are user assignable with respect to MIDI Control Change number, MIDI Channel 
number and a range of values. 

The most common uses of FadeMax are to automate a mix using MIDI instruments or an 
external MIDI controllable Mixer such as the Mark of the Unicorn MIDI Mixer 7, or even MIDI 
controlled lighting consoles. With our SnapShot feature, you can setup sceens for instant mix
changes or lighting cues or other uses. If your device responds to MIDI control changes, the 
uses for FadeMax are endless!

In addition to its controls, FadeMax provides a complete set of editing features, including 
Event List and Graphic editing windows. FadeMax also includes powerful editing transforms 
that let you limit, scale, shift and perform other useful operations to your recording. The Fill 
command makes smooth fades easy to create. FadeMax also includes our innovative Icon 
Toolboxes, with common editing commands just a click away. 



How to Use FadeMax
FadeMax is designed to be run as standalone programs or to be used with another program, 
such as SeqMax. Since the MIDI Director synchronizes all sequencers, FadeMax will play 
along with SeqMax perfectly in time. This is because FadeMax is actually a mixing 
sequencer.

When started, FadeMax displays the Mixer window and the transport bar. The transport bar 
is allways displayed. SeqMax has a full set of transport controls at the top of the screen for 
starting record and playback.Next to the transport keys is a large Time Display. It shows the 
current position in SMPTE time. If you are not actually in SMPTE sync mode FadeMax uses 30
non-drop. Next to the Time Display is the SnapShot button.

Before you use FadeMax you will need to configure the mixer for your equipment. This is 
described detail in the chapter on the Mixer window, under the section on Control Settings. 
You can configure FadeMax for any MIDI device that accepts MIDI control changes.

To Record you simply press the Record button. You can then manipulate the controls to 
record movements, or the MIDI events may be received from the selected MIDI input. When 
you press the stop button, recording is ended and a dialog box is displayed asking whether 
you wish to keep your mix. If you answer Yes, the mix will be saved. 

FadeMax has several record modes. The Overdub mode simply adds any movements or MIDI
events to the existing data. The Replace mode replaces all mix data after a control is moved;
the data for that control before you click on the control is left untouched. Finally, the Scrub 
mode is like a punch in mode where data is only replaced as long as you are manipulating 
the control. When you click on a control, data is replaced until you release the mouse button.



The Transport Bar
The transport bar has controls for record and playback as well as displaying the current 
SMPTE time and the SnapShot button. The transport bar features a standard tape recorder 
style transport consisting of Record, Play, Stop, Rewind and Fast Forward buttons. 

The Record Button puts FadeMax into record mode. FadeMax will record the MIDI data. The 
Play button will playback your mix. Stop will stop Playback or Record. Rewind will wind the 
mix back to the start. Fast Forward will play the mix back at a fast speed. The fast forward 
speed is determined by the MIDI Preferences program. 

The large Numeric display is called the Time Display. The Time Display shows the time in 
SMPTE time in the format of Hours:Minutes:Seconds:Frames. If you are using MIDI Time Code
sync then the frame rate is determined by the SMPTE source. If you are using Internal or 
MIDI sync then the MTC time display will always use 30 frames for display. 

Next to the Time Display is the SnapShot button. The SnapShot button is an alternate 
method of using the Edit menu's SnapShot command. The SnapShot command simply 
inserts the current control settings into the mix track. When you press the snap shot button, 
a dialog is displayed allowing you to specify the SMPTE time where the snap shot is inserted.



The Mixer Window
FadeMax only differ in the number of controls in their Mixer Windows. Once we've described 
the channel layout for the Mixer we'll describe changing individual control settings and 
accessing the edit windows.

FadeMax has sixteen mixer channels, each with a fader, a button, five potentiometers and 
an LED. You also have a label for each row to the left and a tape strip, or comment area, on 
the bottom of the Mixer Window. The Red switch in the top left-hand corner is a 
disable/enable Transport Switch.

Using the Mixer Windows
Modifying Individual Control Settings
Labeling Controls and the Tape Strip
The Transport Switch
Accessing Edit Windows



Using the Mixer Window
The Mixer window is used just like a real mixer. Move the controls as you would a real 
mixer's controls. The only difference is that you use the mouse instead of your fingers. The 
only difference is that MIDI messages, called events, are sent instead of controlling a volume
ot tone circuit.

You can access editing function from the Mixer window's pop-up menu. You can display a the
Mixer's popup menu by pressing the right mouse button with the mouse button over a 
control. This menu has choices for Graphic Editor, Event Editor and Control Settings. The 
Control Settings choice leads to a dialog that allows you to modify the MIDI control change, 
MIDI Channel and range settings for each control. The Graphic Editor and Event Editor 
choices open windows for editing your mix.



Modifying Individual Control Settings
The Control Settings dialog is displayed by selecting the Control Settings choice from the 
Mixer window's pop-up menu. You do this by placing the mouse cursor over a control and 
pressing the right mouse button. This displays the popup menu. Choosing Control settings 
displays the Control Settings dialog. The dialog has selections for MIDI Controller, MIDI 
Channel, Value, and Range.

The MIDI Controller and MIDI Channel settings determine which MIDI control change and on 
what MIDI channel the control sends and responds to.

The Value Start and Current parameters determine the beginning and current value for the 
control. The Minimum and Maximum Range settings determine the valid range of values for 
the control. The control will only send and respond to MIDI events in this range.

Choosing Ok modifies the control's settings while Cancel reverts to the original settings for 
these controls. These values are saved with each Mix and with the Mixer Seup files. 

See the Menu Command reference for more information on saving these types of files.



Labeling Controls and the Tape Strip
The Tape Strip runs along the bottom of the Mix window and is convenient place for 
comments or Mix instructions.

Along the left hand side of the Mixer window are labels for each row of controls. FadeMax has
seven labels. When you mouse the mouse pointer over one of these labels the mouse turns 
into a mouse shape showing you that you can select one of these labels. This label is used in
the Event Editor to identify control events. It is also used for the selecting controls for the 
Event Editor filter and various editing dialogs. You can enter any text you want. Labels are 
saved in Mix session files as well as in Mixer Setup files.



The Transport Switch
The Red switch in the top left-hand corner is a disable/enable Transport Switch. This is used 
to disable or enable playback from FadeMax. What if you wanted to use just the mixing 
capability of the program in real time without recording or playing back anything? By turning
off the Transport Switch, your Big Noise sequencer will not cause FadeMax to start, turning 
FadeMax into a simple mixer panel. You can turn the Transport Switch back on to re-enable 
FadeMax's recording and playback functions.



Accessing Edit Windows
You can access the edit windows from the Mixer window's pop-up menu. You do this by 
placing the mouse cursor over a control and pressing the right mouse button. This displays 
the popup menu. Choosing Graphic Editor or Event Editor    displays an edit window. You can 
also choose an edit window from the Windows menu or with the F11 and F12 functions keys 
on the PC's keyboard.



The Graphic Editor Window
The Graphic Editor is the most powerful editor in FadeMax. You can open as many Graphic 
Edit windows as needed, and each edit window can show different data for different controls.
The Window title bar tells you which control is being edited.

The Graphic Editor window is split into two sections, the edit pane and the status area. The
status area wraps around the edit area and includes the top area where mouse position is 
displayed. The left-hand side of the status area shows the value ruler, while the bottom 
shows the position ruler.

The Edit pane shows you the control events and lets you edit them with your mouse. The 
Graphic Editor has a Toolbox that lets you select what edit mode the edit area is in, lets you
change the window to show other controls and various editing commands.

The Graphic Editor will show only one control at a time. Any editing will only affect the 
displayed mix control.



The Graphic Editor Toolbox
To access the Toolbox, click the Right mouse button over the edit pane. Each button shows a 
different tool or icon. The tool buttons activate different edit tools while the icon buttons 
either change the appearance, control displayed or select edit commands.

You can select one to see its function-

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 



The Pick Tool is the first button. The pick tool is used for block marking in the edit pane.



The Eraser Tool is under the Pick Tool. The Eraser tool will erase single events when 
dragged over the edit pane. If you click the eraser tool over a block marked area it will erase
all events in the block.



The Pencil Tool is selected to add new data. Just as    with a paint program, like Windows 
Paint, you just draw the new information on the edit pane. If you don't drag the mouse, only 
a single event will be added. Program changes and velocities are modified differently by the 
pencil tool. See the discussions above for more details.



The Fill Tool will fill events between two other events. This is useful for making smooth 
changes between events, without trying to draw a straight plot with the pencil tool.



The Scale Icon lets you scale events by a percentage. 100% equals no change, greater 
than 100% increases tempo values while values less than 100% decreases values. It will 
effect a block marked region if a region is marked, or the whole controller's data if no region 
is marked.



The Remove Icon is like using Delete from the Edit menu, except that you can limit the 
range of events to remove. A block must be marked for remove to work.



The No Duplicates Icon  is a way of removing duplicate events. This mostly useful when 
importing MIDI Files, since SeqMax removes duplicates when drawing new events.    If a block
is marked, duplicates will only be removed within the selected block.



The View Icon is used to determine which controller is displayed by both the edit pane. It 
has selections for the Mixer channel and control that you can select.



The Limit Icon lets you limit the range of existing events between user specified values. It 
will effect a block marked region if a region is marked, or the whole mix track if no region is 
marked.



The Smooth Icon lets you add control data to smooth out the effect of the selected control. 
It will effect a block marked region if a region is marked, or the whole track if no region is 
marked.



The Thin Icon lets you remove control data. This is valuable for making the MIDI data 
stream less dense. It will effect a block marked region if a region is marked, or the whole mix
track if no region is marked.



The Goto Icon is an alternate way of selecting the Goto dialog. This is a duplicate of 
selecting the Goto command from the Options menu. You can enter a SMPTE time to jump 
to.



The Invert Icon is used to invert event values. This is a way of turning the data upside 
down. This can change a crescendo to a decrescendo or be used for other creative uses.



The Shift Icon lets you shift control events up or down by an entered value. You can restrict 
this range to affect only certain event values. If you have block marked events, the shift will 
only effect the blocked region. If no block is marked then the entire mix track will be 
modified.



The Zoom In Icon is equivalent to choosing Zoom In from the Windows menu. It will show 
you more time in the Graphic Editor Window with less detail.



The Zoom Out Icon is equivalent to choosing Zoom Out from the Windows menu. It will 
show you less time in the Graphic Editor Window with more detail.



The Grid Icon will display an edit grid. This is usually selected since this makes it easier to 
enter new events where you want them.



The Vertical Grid Icon  will    only display a vertical edit grid. 



The Horizontal Grid Icon  will    only display a horizontal edit grid. 



The No-Grid Icon removes the grid from the edit area. If you like a totally clean edit 
window, choose this.



The Event List Editor
The Event List Editor lets you view and edit control events as text. It shows a list of events in
each track. You can also limit the types of events displayed using the Event List Toolbox's 
View Icon. The event list will also accept and display Program Change events. These are 
useful for changing your instrument's configuration. 

The list is displayed from the beginning of the mix track to the end. The scroll bar lets you 
scroll through the list.

To edit an event you can move the position marker to the event you want to modify with the 
cursor pad and press enter. You can also double click on an event to edit. You can insert an 
invent by choosing the Add Icon from the Event Edit Toolbox, or by pressing the insert key. 
Adding or insering displays the Event Edit dialog. The the section on the Event Edit dialog is 
after the section on the Toolbox.You can remove events with the delete key or with the 
Eraser Tool from the toolbox. 

The event editor will show program change and control events for all the mix controllers or 
just those selected using the Toolbox's View Icon.

The Event Editor's Toolbox gives you several options for editing control events and changing 
the events the Event Editor window displays. 



The Event Editor Tool Box
To access the tool box, click the Right mouse button over the Event Edit Window. Each 
button shows a different tool or icon. The tool buttons activate different edit tools while the 
icon buttons either change the appearance, control displayed or select edit commands. 

You can select one to see its function-

 

 

 

 

 

 

 

 

 

 

 

 

 



 



The Pick Tool is used for block marking and selecting events for editing.



The Eraser Tool will erase single events when clicked on single events. If you click the 
eraser tool over a block marked area it will erase all events in the block.



The Goto Icon is an alternate way of selecting the Goto dialog. This is a duplicate of 
selecting the Goto command from the Options menu. You can enter a SMPTE time to jump 
to.



The View Icon is used to determine what mixer control events and mixer channel are 
displayed.



The Limit Icon lets you limit the range of existing events between user specified values. It 
will effect a block marked region if a region is marked, or the whole mix track if no region is 
marked.



The Scale Icon lets you scale events by a percentage. 100% equals no change, greater 
than 100% increases values while values less than 100% decreases values. It will effect a 
block marked region if a region is marked, or the whole controller's data if no region is 
marked.



The Invert Icon is used to invert event values. This is a way of turning the data upside 
down. This can change a crescendo to a decrescendo or be used for other creative uses.



The Shift Icon lets you shift control events up or down by an entered value. You can restrict 
this range to affect only certain event values. If you have block marked events, the shift will 
only effect the blocked region. If no block is marked then the entire mix track will be 
modified.



The Remove Icon is like using Delete from the Edit menu, except that you can limit the 
range of events to remove. A block must be marked for remove to work.



The No Duplicates Icon  is a way of removing duplicate events. This mostly useful after 
recording. If a block is marked, duplicates will only be removed within the selected block.



The Add Control Event Icon is a method of adding control events. Selecting this will 
display the Event Edit Dialog, set up to add a control event. This lets you add single events 
easily. The Event Edit dialog is described after the toolbox is described.



The Add Program Change Event Icon is a method of adding program change events. 
Selecting this will display the Event Edit Dialog, set up to add a control event. This lets you 
add single events easily. The Event Edit dialog is described after the toolbox is described.



The Grid Icon will display an edit grid. This is usually selected since this makes it easier to 
see what an event's value is.



The No-Grid Icon removes the grid from the event list. If you like a totally clean window, 
choose this.



The Event Edit Dialog
When you select an event for editing, or you choose an Add icon in the toolbox, FadeMax 
displays the Event Edit Dialog. The Edit Event Dialog lets you change an event's settings. 
You can change a program change to a controller, or change an event from one mix control 
to another.

We will discuss each edit field and any details you need to remember when using the Event 
Editor Dialog. 

The Time parameter is the SMPTE time of the event. 

The Controller and Program Change buttons let you change or select which type of event
the event is. Just press the appropriate button to select the event type.

The Channel dropdown box lets you select a mixer channel for Controller events or a MIDI 
channel for Program Change events.

The Value is the value for the event. For program change events, this is the patch number. 
For mix controls this is a value in the control's valid range.

The Ok and Cancel buttons exit the Event Edit Dialog. Ok adds the event or saves the 
changes entered. Cancel makes no changes.



Menu Commands

The FadeMax menu bar has commands for loading and saving mixes, editing data, selecting 
difference options and doing cut, copy and paste operations. To select a menu you just click 
on the menu title to display each menu.

File Menu
Edit Menu
Options Menu
View Menu
Window Menu
Help Menu



File Menu
The File menu contains commands for loading and saving mix sessions. There are also 
commands for loading and saving Mixer Setups and for exiting FadeMax.

          New Session ...
          Open a Session ...
          Save Session

Save Session As...
Export As a MIDI File
Store Mixer Setups ...

          Load Mixer Setups ...
Exit



New Session ... Ctrl+N

This selection clears the sequence and reloads the default Mixer parameters from the 
default setup file. Use this to start a new session. All aspects of the session are reset.



Open a Session ...Ctrl+O

Select this command to load an existing session. When you select this command, you will be
given an option to save changes, if any,    to the current session. The File Open dialog is then 
displayed.
The File Open dialog has an Edit field for the name of the file to load. Below that are the list 
boxes for any existing sequence files and a list box for the drives and directories. The default
file extension for FadeMax session files is ".MMM", and only files with the correct extension 
will be displayed in the file list.
You can select a session by either typing its name in the File Name Edit field, or by clicking 
on its name in the Files list. Once you've selected a file press the Ok button to load it. A Load
dialog will be displayed tracking the load progress. If you press Cancel instead of Ok, then no
file will be loaded. FadeMax can only load FadeMax format files.



Save Session Ctrl+S

This selection will save the existing session to disk with the same file name. If you try to 
save a new song, the Save command will automatically activate the Save Session As ... 
command to give you a change to give the session a name.



Save Song As... Ctrl+A

The Save Session As... command gives you an option to name the current song before 
saving it. It displays the Save Session dialog, which is laid out exactly like the Open Session 
dialog. Enter a name for the session in the File Name field. Don't forget to add the ".MMM" 
for FadeMax sessions so it will displayed in the Open dialog.



Store Mixer Setups ...

This option lets you store the current mixer settings to a file for later retrieval. This option 
stores all the settings in the Options menu, in addition to all mixer control settings. 



Load Mixer Setups ...

This option lets you load mixer setup files you've saved using the Store Settings command. 
You can load a Mixer setup over an existing session to change all mixer control settings, 
while keeping all existing control data.



Exit

Lets you leave FadeMax. If the current session has not been saved, you will be given an 
option to save it before exiting.



Export as a MIDI File...

This command lets you store MIDI Files for export to other programs, such as SeqMax. This 
lets you combine your mix with your sequence for live playback with JukeMax. Some 
programs may not be able to read these files since they are in MIDI Time Code/SMPTE 
format. You can use a sequencer such as SeqMax to convert them into beats and ticks 
format for other programs that can't read MTC/SMPTE encoded files.



Edit Menu
The Edit Menu contains commands for manipulating mix track data. There are also options 
for copying settings and data from one control to another. The editing commands in the Edit 
menu are governed by the current block mark and type of graphic or event editor displayed. 
If no block is marked, these commands work on the whole mix track for the control 
displayed. You cannot use many of these commands in the Mixer window. These will be 
grayed out when the Mixer is displayed. 

Undo
Cut

          Copy
          Paste
          Delete

Clone a Control ...
SnapShot ...
Remove Duplicate Events
Limit...
Scale...
Invert...
Shift...
Remove Matching Events...



Undo Ctrl+Z

This option reverses the last edit command. It will restore the session back to where it was 
before the edit command took place. This command is only highlighted if there is something 
to Undo.



Cut Ctrl+X

This command copies block marked data to the clipboard and then removes the data from 
the mix track. 



CopyCtrl+C

This command copies block marked data to the clipboard, but unlike Cut, it does not remove 
the data from the mix track.



Paste Ctrl+P

Paste lets you copy data from the clipboard into the mix track. You can paste from one 
control to another.

If you paste in the Graphic Editor, the mouse cursor will change into a Paste bucket. You can 
then click where you want the events to be pasted.

When Pasting into the Event Editor, the events will be pasted into the event editor at the 
current position.



Delete Del

The Delete Command lets you remove events from a track.    You must select a block mark to
use this command.



Clone a Control ...

This command works in all windows and lets you copy various control settings and data from
one control to another. When selected, the Clone Controller dialog is displayed. 

On the left side of the dialog are selections for selecting the controller to copy the 
information from and where to copy to. You can copy to just one control, to all controls of a 
selected mixer channel or row, or to all controls. This lets you easily make all ranges, MIDI 
channels or data match on any combination of controls. 
On the right side are checkboxes for the settings and the data. The checkbox selections 
correspond to the settings found in the Controller Settings dialog. The last checkbox lets you
select whether the controller data will be copied. 



SnapShot ...

The SnapShot command simply inserts the current control settings into the mix track. When 
you press the snap shot button, a dialog is displayed allowing you to specify the SMPTE time 
where the snap shot is inserted.



Remove Duplicate Events

Remove Duplicate Events    is a way of removing duplicate events. This mostly useful after 
recording. If a block is marked, duplicates will only be removed within the selected block.



Limit...

The limit command lets you limit the range of existing events between user specified values.
It will effect a block marked region if a region is marked, or the whole mix track if no region 
is marked.



Scale...

The scale command lets you scale events by a percentage. 100% equals no change, greater 
than 100% increases values while values less than 100% decreases values. It will effect a 
block marked region if a region is marked, or the whole controller's data if no region is 
marked.



Invert...

The Invert command is used to invert event values. This is a way of turning the data upside 
down. This can change a crescendo to a decrescendo or be used for other creative uses.



Shift...

The Shift command lets you shift control events up or down by an entered value. You can 
restrict this range to affect only certain event values. If you have block marked events, the 
shift will only effect the blocked region. If no block is marked then the entire mix track will be
modified.



Remove Matching Events...

The Remove Matching Events command is like using the Delete command, except that you 
can limit the range of events to remove. A block must be marked for remove to work.



The Options Menu
The Options menu sets various program-wide options, plus selections for MIDI Ports used, 
the current record mode and starting the MIDI Control Panel.

Goto Time
MIDI Port Selections...

          Record Mode ...
          Echo MIDI Events
           Automatic Rewind
           Start with Edit Grids
           MIDI Control Panel



Goto Time

This command lets you move the current SMPTE position to a new location by entering a 
new SMPTE location. You enter the new position in MTC/SMPTE time in the form of 
Hours:Minutes:Seconds:Frames.



MIDI Port Selections...

This selection allows you to choose which MIDI Input to record from and which MIDI Output 
port to play back on.



Record Mode ...

FadeMax has several record modes. The Overdub mode simply adds any movements or MIDI
events to the existing data. The Replace mode replaces all mix data after a control is moved;
the data for that control before you click on the control is left untouched. Finally, the Scrub 
mode is like a punch in mode where data is only replaced as long as you are manipulating 
the control. When you click on a control, data is replaced until you release the mouse button.



Echo MIDI Events

When checked, this will echo all MIDI events from the MIDI interface's input to it's output. 
How it is routed is controlled from the MIDI Control Panel.



Automatic Rewind

When checked, this command causes FadeMax to rewind the mix after playback is stopped. 



Start with Edit Grids

If this option has been selected any new editors will be opened with an edit grid. If not no 
grid will be displayed when an edit window is opened.



MIDI Control Panel

This option starts the MIDI Director Control Panel. In the MIDI Director Control Panel you can 
change settings for the current sync mode and settings, metronome settings, whether MIDI 
Clocks are transmitted during playback and several other useful settings that effect all 
programs run on the MIDI Director. 

The most important parameters are the Sync settings, found in the MIDI Control Panel's Sync
Settings command, under the Settings menu. In this dialog you can set MTC/SMPTE offset 
and delay.

For more information about the MIDI Director Control Panel see the MIDI Director Reference.



View Menu

The View menu contains commands for Zoom In, Zoom Out, Showing a Grid in the edit 
windows or not showing a grid.

          Zoom In
Zoom Out
Show Grid

          No Grid



Zoom In Num +

This zooms in the current Graphic Edit window to show greater detail. You can also perform 
this command with the Zoom In Icon in the edit window tool boxes. You can also press the 
Plus(+) key on the numeric keypad to Zoom In.



Zoom Out Num -

This zooms out the current Graphic Edit window which shows more events at once, but in 
less detail. You can also perform this command with the Zoom Out Icon in the edit window 
tool boxes. You can also press the Minus(-) key on the numeric keypad to Zoom Out.



Show Grid

This turns the Grid on in the Event and Graphic Edit windows. You can also perform this 
command with the Grid Icon in the edit window tool boxes. Grids are convenient for aligning 
events in these editors.



No Grid

This turns the Grid off in the Event and Graphic Edit windows. You can also perform this 
command with the No Grid Icon in the edit window tool boxes. Choose this option if you 
prefer a clean edit window.



The Window Menu
The Window menu contains commands that open, manage and control the appearance of 
the windows in FadeMax. The last number of selections in the window let you select active 
windows.

Horizontal Tile
Vertical Tile
Cascade
Arrange Icons
New Graphic Editor
New Event Editor

1. Mixer
2. ...    Any other open windows.

The first items is always the same. it is the Mixer window selection. Any Graphic Editors 
and Event Editors that you open will be displayed as items 2 on, allowing you to easily 
select any edit window you have open.



Horizontal Tile Shift+F4
This command arranges all currently open windows horizontally, or one over another,    in 
FadeMax's main window. It will not affect windows displayed as icons. Use this command to 
rearrange windows so that you can view all the edit windows with song positions aligned.



Vertical Tile Ctrl+F5
This command arranges all currently open windows vertically, or side by side,    in FadeMax's 
main window. It will not affect windows displayed as icons. 



Cascade Shift+F5
Cascade displays all open windows overlapped so that their title bars are showing. This 
command is useful if have a lot of open windows and have lost track of them. By cascading, 
you can quickly see which windows are open and select among them.    It will not affect 
windows displayed as icons. 



Arrange Icons
This will rearrange all the Icons displayed at the bottom of FadeMax's main window. If you 
have minimized several windows and moved the ions around this will clean up the display of 
the icons in the main window.



New Graphic Editor F11
This command will open a new Graphic Editor, for editing MIDI events in the currently 
selected track    or pattern (when the pattern editor is on top). See the section on the 
Graphic Editor for information on using the Graphic Editor.



New Event Editor F12
This command will open a new Event Editor, for editing MIDI events in the currently selected 
track or pattern (when the pattern editor is on top). See the section on the Event Editor for 
information on using the Event Editor.



Help Menu
The Help menu contains selections for accessing on-line help from within FadeMax as well as
a selection for showing FadeMax's About box.

Index
Keyboard
Using Help
About ...



Index F1

The Index commands shows you an index of the topics available for help.



Keyboard

This selection shows you the keyboard commands available in FadeMax.



Using Help

This command brings up the help file for the Windows Help Program, which is used to show 
FadeMax's help file. It will instruct you on how to move around and use the Windows Help 
engine.



About ...

The About selection shows FadeMax's About dialog. This dialog displays programmer credits,
your serial number, the version number and the copyright information on FadeMax.
 



Keystroke Equivalents
FadeMax uses the mouse for most operations, but sometimes it is more convenient    and is 
faster to use the PC keyboard. This section lists the keystroke equivalents for many 
operations.

Function Keys

KEY OPTION
F1 Help
F2 Play
F3 Record
F4 Stop
F5 Rewind
F6 Fast Forward
F10 Activate Menu Bar
F11 Open a New Graphic Editor
F12 Open a New Event Editor
Numpad + Increment a value in the Track Sheet. Zoom In in the edit windows.
Numpad - Decrement a value in the Track Sheet. Zoom Out in the edit windows.

UpArrow
DownArrow Up and down arrows move up or down an event in the Event Editor.
Home Moves to the top of the Event List Edit window.
End Moves to the end of the Event List Edit window.
PageUp Moves up on screen full of events in the Event List Edit window.
PageDown Moves down on screen full of events in the Event List Edit window.
Insert Inserts events in the Event List Editor. 
Delete Deletes events in the Event List Editor.    Deletes the current block marked 

events in the graphic editors.
Enter Activates the appropriate Edit Dialog in the Event editor.
Space Activates Play when in stop mode, Stops when in play mode.
Shift+F4 Horizontally tile all open windows
Shift+F5 Cascade all open windows

Shift+UpArrow
Shift+DownArrow
Shift+PageUp
Shift+PageDown
Shift+End Moves the cursor the same way as when the key is unshifted, but block 

marks while doing so. Block Marks Events in the Event List Editor.
Shift+mouse Block marks to the point where the mouse is clicked from the currently 

marked item.
Ctrl+F4 Close the current window
Ctrl+F5 Vertically tile all open windows



Ctrl+F12 Show Pop-up menu of Editor Toolbox
Ctrl+A Save Session As ...
Ctrl+C Copy
Ctrl+N New Session
Ctrl+O Open
Ctrl+S Save Session
Ctrl+V Paste
Ctrl+X Cut
Ctrl+Z Undo
Alt Activates the Menu bar.
Alt+underlined key Activates menu bar menu, whose title contains the 

corresponding underlined character. Moves the cursor to the item with the 
corresponding underlined character in dialogs.

Alt+F4 Exit FadeMax



Glossary

Aftertouch Additional pressure applied to a key after a note is started. Channel Aftertouch
affects all notes on a channel, while Key Aftertouch, also called Key pressure, only affects 
one pitch.
Bank Select Bank select allows you select among several sets of program change groups. 
Since MIDI only defines 128 program changes per MIDI channel, bank select is used to 
expand this number to over two million choices. In reality, most instruments have less than 
10 banks, with the majority only having one bank of program changes.
Block Marking Marking is selecting a group, or block, of items on the screen. The 
block marked area on the screen is displayed in reverse video. Block marks are used to limit 
the range and effect of the edit commands.
Click Press the left or right mouse button once
Clipboard The clipboard is a temporary storage area for Cut, Copy and Paste operations. 
Data is placed in the clipboard by Cut and Copy commands. It is retrieved by using the Paste
command. The Clipboard is lost when FadeMax is exited.
Ctrl+Click Press the mouse button down, while holding the Control (Ctrl) key down.
Controller, or Control Change A controller is a way of instructing an instrument to turn 
its volume up, pan the stereo image of the sound, add more of an effect or simulate a 
sustain pedal when using a piano sound. The uses of controllers are so varied that no 
instrument uses all controllers, so you need to look at your instrument's MIDI 
implementation charts to find out which Controllers you instrument uses.
Drag Moving the mouse while holding the left mouse button down.
Double-Click Press down a mouse button twice rapidly.
Duration The length of a note.
Events An Event, or MIDI Event, is a message sent by a keyboard to the computer. 
These messages represent notes and control the MIDI equipment that when sent to an 
instrument play the same action back.
Key Pressure Additional pressure applied to a key after a note is started. Key 
Pressure, also known as Aftertouch, only affects one pitch.
MIDI An acronym that stands for Musical Instrument Digital Interface, the standard way 
that modern electronic instruments communicate with each other and with computers.
MIDI Echo Also known as MIDI Thru, MIDI Echo is the action of sending all data received 
at the MIDI input to the output in realtime. This is convenient for monitoring a performance.
MIDI Event A message sent between various MIDI devices to cause a note to be played or 
some action to be taken.
MIDI Channel A logical division for MIDI messages. MIDI is like a network and MIDI 
channels act like addresses. Each part to be played by an instrument is assigned a different 
MIDI Channel.
Mouse Cursor The pointer on the screen, which is most often an arrow shape, that is 
used to select an item on the display.
Open In windows to load data or activate a program or window.
Overdubbing To add more notes to already existing notes in a track.
Pitch Bend Also known as Bender, pitch bend is generally used to simulate the way a 
guitarist bends a string to stretch a pitch.
PPQN Pulses Per Quarter Notes. The resolution used for one quarter note, which is 480 ticks
for all MIDI Director applications.
Program Change Also known as Patch change, program change tells an instrument to 



select a new sound or setup.
Resolution The accuracy with which notes are timed.
SelectTo click the mouse with the cursor over a screen item.
Shift+Click Press the mouse button down, while holding the Shift key down.
Song Position The song position is a way of representing a place in time in the song. 
Song Position is represented in Ticks in a Measure:Beat:Tick format.
System Exclusive A manufacturer specific way of representing data that is used only by 
that manufacturer's instrument. System exclusive can be used to transfer sound data, 
change effects settings or change the basic tuning of an instrument.
Window A window is a retangular area on the screen that is used by a program to 
display information and receive information. You should read your Windows user's guide for 
an understanding of Windows and the concepts of how to use them.



Information and Trivia
Timer Resolution
The MIDI Director uses a tick rate of 480 ticks per quarter note. It also generates a 
millisecond based reference clock.

Maximum Number of Running Programs
The number of MIDI Director programs that can be run is between eight and sixteen 
programs. Most sequencers use two data streams, but other programs, such as LibMax the 
Generic Librarian only use one.

Maximum Number of MIDI Interfaces
The number of MIDI Ports the MIDI Director supports is sixteen MIDI inputs and sixteen MIDI 
outputs. These MIDI Ports can be on any combination of up to eight physical interface cards.

Filenames and Extensions used by FadeMax

FadeMax uses the following file extensions. Each extension is listed with the kind of file data 
it represents.

filename.FMM FadeMax Mix Session file. This is the native file format for saving FadeMax 
sessions. 
filename.FMS FadeMax setup file. This format saves all control and Option menu    settings. 
The default Setup file is named Default.FMS. If this file is present, FadeMax will read it on 
startup to setup each session.



Error Messages

Can't Load Control Library File (BNCTRL.DLL)
Can't Load MIDI Director Library File (MIDIDIR.DLL)
Can't Load MIDI Director Control Panel.

One of the Control Files needed to run FadeMax is missing. Try reinstalling from the original 
program disks.

Can't Find the Digital Font File.
Can't Create the Digital Font. You might be out of Windows Resources.

One of the Font Files needed to run FadeMax is missing. Try reinstalling from the original 
program disks.

Can't Lock MIDI Input Buffer. Aborting ...
Can't Lock MIDI Output Buffer. Aborting ...
Can't Page Lock MIDI Output Buffer. Aborting ...
Can't Page Lock MIDI Input Buffer. Aborting ...
Error Openning MIDI Data Stream.
Trouble Allocating MIDI Input Buffer.
Trouble Allocating MIDI Output Buffer.

There probably isn't enough memory to run. Try unloading some programs and restart 
FadeMax.

Out of memory. [further message] 
Trouble Locking Mix Track!
Problem Locking Record Buffer.
Not enough memory for Edit Window.

There probably isn't enough memory for the option you've selected. Try unloading some 
programs and restart FadeMax.

Problem writing to your Disk. You may be out of disk space.
Your disk is either write protected or full.

File Header is not correct. File is corrupt or not of the correct type.
The file has been damaged and can't be read. I hope you've got a backup.

Can't Fill ...You Need at least two events to fill in between.
The fill command requires at least two events on either side to fill between.

Not Enough Memory for Clipboard. Nothing will be Copied.
Can't Lock down Clipboard Memory. Nothing will be Copied.
Can't Open the Clipboard.
Can't Open Undo File. You won't be able to Undo This Edit.

There's a problem with the Clipboard. You might be out of memory or out of disk space.






